Converting a Reference Manager 11 or 12 database to an EndNote library is not difficult and requires no
importing or exporting of text files. If you have customized your Reference Manager reference types and

fields, you can even customize the mapping of those reference types and fields during the conversion
process.

Note that the conversion will make no changes to the original Reference Manager database.
It is important the steps below be followed in the order shown.

¢ In EndNote, select Open Library from the File menu.

File | Edit References Groups Tools Window He
Mew...
Open Shared Library... Ctrtl+Shift+ 0
Open Recent 3

e In the Select a Reference Library window, navigate to the folder containing your Reference
Manager database and select Reference Manager Databases (*.rmd) from the drop-down list of
file types.

Select a Reference Library:

@uv| . v Libraries » Documents » Reference Manager12 » Database v|¢?|| Search Database }Dl

Organize « Mew folder e 0 '@'

-

't Favorites Documents library
Bl Desktop Database
4. Downloads

Arrange by:  Folder «

-

Name Date modified Type Size

m

= Recent Places

& Downloads 2 _ Mo iterns match your search.

File name: - lLibraries (*.enl;*lib;*.enk) v]

Libraries (*.enl;* lib;*.enb)

ProCite Databaszes (*.pdt)
Reference Manager Databases (*.rmd)
All Files (*.%) -

e You will now see the Reference Manager database in the folder. Select it, then click on the Open

button.
Sel'ecta Reference Library:
- Ty
@uv| . «¢ Documents » Reference Manager12 » Database - |¢,|| Sea }Dl
Organize New folder = o+ 0 I@l
't Favorites Documents library Arange by: Folder ~
Ml Desktop Database
% Downloads 3 MName : Date modified Type
2| Recent Places
& Downloads2 |3 Sample.rmd 6/2/2015230PM  RMD File |
- 4 1 ¢
File name: ISampIe.rmd vI ’Reference Manager Databases ( VI
ﬁ[ Open |v] ’ Cancel ]
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e |If you have changed any of your reference types or fields in Reference Manager, click the
Customize button to customize the field mappings. (Click here to continue with the uncustomized

conversion instructions.)

Convert Reference Manager Database

Click "Convert..." to open this Reference Manager® database.
Conversion will not affect your original Reference Manager files,

Click "Customize...” to modify the default mapping of Reference Manager
fields to EndMote fields prior to conversion.

(]

_ [ convert... |

[ Cancel

e

o |fyou have selected to customize your conversion, in the top half of the reference and field mapping
window you can select the EndNote reference type that each Reference Manager reference type
will import as. For example, in the screenshot below it shows that any reference that was entered
as an abstract in Reference Manager will be imported as a journal article in EndNote. You can
change these options if you wish using the drop-down list for each match in the EndNote column.

Reference Manager to EndMote Reference & Field Mapping

Audiovisual Material

Generic

Reference Types

Reference Manager EndNote

Generic Generic 7
Abstract Journal Article -
Art Work Film or Broadcast -

Government Document

Grant
Hearing

Magazine Artide

(]

o

¢ |Inthe bottom part of this window you can select the specific fields in EndNote that each Reference
Manager field will map to for the shown reference type. In the screenshot below, the Pub Date field
for the Journal reference type in Reference Manager is being mapped to the Date field in EndNote.

Fields For: Journal

Reference Manager EndMote

Title Title -
Authors Author -
Pub Date Date -
Motes Motes ~

Reset to Default Map

Ok

] [ Cancel

June 5, 2015 Reference Manager Conversion 06-05-15.docx

Thomson Reuters© 2015

Page 2 of 9



e When all reference types and fields are mapped as you wish, click the OK button to finalize the
field and reference type customizations. Please note the field mappings will need to be set for each
database converted.

Reference Types
Reference Manager
Generic

Abstract

Art Work

Audiovisual Material

Fields For: Generic
Reference Manager
Title, primary

Authars, primary

Date primary

Motes

[Resetmfﬁ[ ok | |

Reference Manager to EndMote Reference & Field Mapping

Endlote

==

[Generic

-] -

[Journal Article

[.ﬁ.rtwnrk

)

[Audinvisual Material

Endliote

’ Title

l.ﬁ.uthcr

|Date

’Notes

-

e Click the Convert button to convert the database.
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Convert Reference Manager Database

Click "Convert..." to open this Reference Manager® database.
Conversion will not affect your original Reference Manager files.

Click "Customize...” to modify the default mapping of Reference Manager
fields to EndNote fields prior to conversion.

[ Cancel

ﬁ[ Convert... |

Reference Manager Conversion 06-05-15.docx
Thomson Reuters© 2015

Page 3 of 9



e Give your new EndNote library a name. We suggest saving the new library in your main documents
folder. Never save an EndNote library in an online service such as Dropbox, OneDrive, Google
Drive, SharePoint, or similar online (“‘cloud”) storage. These services will corrupt an EndNote
library. We also suggest you avoid putting a read-write copy of an EndNote library on a network
drive. We have seen corruption and performance issues with read-write libraries on network drives.
It is best to store your library on your computer’s hard drive. Click the Save button to save your

new EndNote library.

, Save Converted Library as @
@le . Libraries » Documents » RM Samples - | "‘Pl | Search AM Samples g ol |
Organize « Mew folder 4= - .j:@_.

- .
,\-;a[\;or::tes E?Sca : :Lents library Amange by: Folder +
esktop e nles
% Downloads MName . Date modified Type

| Recent Places

4 Downloads 2 No items match your search,

- ¢ T
File name: m -
Save as type: lEndNote Library (*.enl} vJ

2! Hide Folders ﬂ Save | | Cancel |

If you plan to share your library with multiple EndNote users, EndNote offers several options for this. See
the Collaboration chapter of The Little EndNote How-To Book for more information.

o If there were attachments in your Reference Manager database, EndNote will show the screen
below, asking if you would like to convert them to relative links (attachments) in the EndNote library.
This will copy the attachment files to the .data folder of the EndNote library and create links between
the attachments and the matching records in the library. Click the Yes button to convert
attachments. If you choose not to convert attachments, links to the original attachments will remain,
but if you move your library to a new computer those links may be broken if the same directory
structure does not exist on the new computer.

r

Convert Reference Manager Database £

"-.I Your Reference Manager database has been converted,
¥ Would you like to convert your file attachrment links to relative for this
EndMote Library?

ﬁ[ Ve || No
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e You will receive a message of how many links have been converted. Click the OK button.

[ =

Converting Links @

:I 24 links in 24 references were successfully converted to relative links.

e Your new EndNote library will be displayed. The paperclip icons below show there are files attached
to the Brill, 2001 and Connor, 2001 records. Any type of file can be attached to an EndNote record
and each record can have up to 45 attachments.

21 EndNote X7 - [Sample.enl] [E=H B X"

@File Edit References Groups Tools Window Help —|[= =

@s&|mﬂnotated - “@ﬁ(’ @" |‘ &4

- - -
My Library o & Author Year Title “  Reference | Preview @Elill-zﬂm-;ssessmel 9 4 »
] Brager, 5.; Wursi... 1994  Association patterns of bottle-nosed dolphins (Tur...
. Reference Type: Journal Article -~ ﬂn -

L) Brensing, K; Lin... 2003 ‘Can dolphins heal by ultrasound? E|

0| Quick Search J =~ ¥ Show Search Panel

Al

[um | »

Unfiled (155)
Brill, R.L.; Moore... Rating
4 Trash 0) o 0
Buck, J.D.; McCa.. 1994  Occurrence of non-ol vibrio-cholerae in Texas gul...
= My Groups Buck. L.R.; Tyack... 1993 A quantitative measure of similarity for Tursiops tr.. Author

Caswell, H.; Brau... 1994 Rate of increase in harbor porpoise populations: Es... Brill, R.L.
Cheal, AJ.; Gales... 1992 ‘Growth, sexual maturity and food-intake of Austra.. Moore, P.W.B.
Chou, L; McClint.. 1993  Technology and education: New wine in new bottl.. || D2nkewicz LA
Cockeroft, V.G. 1992  Incidental capture of bottle-nosed dolphins (Tursio.. Year
Cockcroft, V.G.;.. 1991  Distribution and status of bottle-nosed-dolphin Tu... || 2001
Cockcroft, V.G ... 1992 Estimates of abundance and undercounting of bott.. 'I:tle f dolphin (T ) sud
. P 9 ssessment of dolphin (Tursiops truncatus) auditory
g:f::; ?: . Hei. i:;—; :ﬂlﬁmwmfxrhzr:::f;ﬁ:;mtgat sensitivity and hearing loss using jawphones

= Find Full Text

Journal
= || Journal Of The Acoustical Society Of America
< " | r [T

e oo 0e oo 0 o

&? Connor, R.C; Hei... 2001 ‘Complex social structure, alliance stability and mati.

Showing 155 of 155 references. IE‘ Layout ~
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e Although you normally would not see the codes shown here, what you see below is an example of
the actual coding that is inserted into your documents when you use Reference Manager’s Cite
While You Write in Word. The code starts with the text “ADDIN REFMGR.CITE” because this
citation came from Reference Manager. These Reference Manager codes need to be converted to
EndNote codes if you want to continue working with them using EndNote. (The field codes are
shown by using the Toggle Field Codes command in Word. You do not need to do this to convert
the citations.)

mil=! O A A RM Sample Doc.docx - Microsoft Word o B &5

Home  Insert  Pagelayout  References  Mailings  Review  View | EndNote)7 o @

5@ Go to EndNote
3

Insert
Citation = 42 Edit Library Reference(s)

= Edit & Manage Citation(s)

Style: | APAGth -
=% Update Citations and Bibliography
= Convert Citations and Bibliography -

= Categorize References -

27 Instant Formatting is Off ~

3 Export to EndNote -
o Preferances

? Help

Citations Bibliography Tools

(W B S S B S R S,

» [

Legends of the friendliness and helpfulness of dolphins have existed for centuries.{ ADDIN REFMGR.CITE —
: <Refman><Cite><Author>Anderson</Author><Year>1978</Year><RecNum>77</RecNum><IDText>Ario
- n and the dolphins: Based on an ancient Greek legend</IDText><Pages>23</Pages><MDL

' Ref Type="Book, Whole"><Ref Type>Book,

] Whole</Ref_Type><Ref_ID>77</Ref_ID><Title_Primary>Arion and the dolphins: Based on an ancient

: Greek

legend</Title_Primary><Authors_Primary>Anderson,L.</Authors_Primary><Authors_Primary>Adams,A.
</Authors_Primary><Date_Primary>1978</Date Primary><Keywords>dolphin</Keywords><Keywords>

dolphins</Keywords><Keywords>folklore Greece</Keywords><Reprint>Not in
File</Reprint><Pub_Place>New
York</Pub_Place><Publisher>Scribner</Publisher><ISSN_ISBN>0684151286</ISSN_ISBN><7Z Workfor
miID>2</ZZ WorkformID></MDL></Cite></Refman>}

e The screenshot below is what you would normally see with Reference Manager citations in the
document. The codes are shown above just to give you an idea of what is really there.

@ U A Al= RIM Sample Doc.docx - Microsoft Waord - B =
Home Insert Page Layout References Mailings Review View EndNote X7 - @
;@\ Go to EndNote Style: | APAGth ~| = Categorize References = 4] Export to EndMote -
N S Edit & Manage Citation(s) | 5% Update Citations and Bibliography 23 Instant Formatting is OFf ~ | <o Preferences
Insert
Citation VEdit Library Reference(s) BConvert Citations and Bibliography ~ ? Help
Citations Bibliography Tools
[, 1 IR O R | i T X 7 ]
-

Legends of the friendliness and helpfulness of dolphins have existed for centuries.(Anderson & Adams,
1978,p. 23)
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e Select the entire Reference Manager bibliography, as shown below, and delete it. A new EndNote
bibliography will be generated at the end of the document when the citations are converted.
@| H9-0 A‘- 4_4 = RM Sample Doc.docx - Microsoft Word = @ 52
“_Hnma Insert  Pagelayout  References  Mailings  Review  View | EndNoteX7 @
E& G0 Go to EndNote Style:  APAGth ~| = Categorize References 4] Export to EndNate ~
™ =P Edit & Manage Citation(s) 5% Update Citations and Bibliography [23) Instant Formatting is Off ~ | ¢ Preferences
G{!;;’;. +# Edit Library Reference(s) = Convert Citations and Bibliography ~ ? Help
Citations Bibliography rl Tools
’_@1"""‘""1"‘?"'!"'.1"'!"‘?‘“1“‘7"'!"'.5"" s z | [

Legends of the friendliness and helpfulness of dolphins have existed for centuries.(Anderson & Adams,
1978,p. 23)

“ 0 rd

Page:1 ofl | Wordsi21/38 | <5

English (U.5) |

IEEEEEE e o
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Select Convert Reference Manager Citations to EndNote from the drop-down Convert
Citations and Bibliography list in the Bibliography group.

yout

Style:
=¥ Update Citations and Bibliography

References Mailings Review View EndMote X7

APABth = £ Categorize References ~

Instant Formatting is Off =

a Convert Citations and Bibliography ']

é) Convert to Unformatted Citations 4
Ca Convert to Plain Text c 3

Ryt Convert Reference Manager Citations to EndMote h

@ Convert Word Citations to EndMote

EndNote will display the screen below, where you can select a style and set layout options much

as you can in the Configure Bibliography window in EndNote. Set your options, then click the OK
button.

r

EndMote X7 Convert Reference Manager Citations

Format Bibliography |Ten1|:n.'.'nrar1,|uI Citations | Layout|

Format document: [RM Sample Doc.docx

)

v] [ Browse... ]

With output style: [ aPA 6th

[T Link in-text citations to references in the bibliography

Underline linked in-text citations

q ok || cancel || Heb
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e The bibliography and citations look the same at first glance, but they are now EndNote citations
and bibliography instead of Reference Manager. Note that in this example even the page number
in the citation was converted.

3. Replace

W =95 A A= RM Sample Doc.docx - Microsoft Word L om =
Home | Insert  Pagelsyout  References  Mailings  Review  View  EndMote X7 @
= & cut - A L E, iz . iz .= A ) 3 Find -
E Galiori (Body) =31 " A a7 Aam |y =TS Bl | T pasbcene | aabcepe| asBbcede AaBbCi AaBbce AADB %
=

-Ya
Paste . i _| Change
S o Format Painter o R TEndNote... | TNormal |7 MaSpaci. Headingl Heading 2 Title =| ShRnSE | v seteet -

Clipboard . Font 3 Faragraph . Styles 2| Editing

o e A ]

B 7 U ~abe x, X°

i

» [

Legends of the friendliness and helpfulness of dolphins have existed for centuries.(Anderson & Adams,

1978,[p. 23)

= Reference List

Anderson, L., & Adams, A. (1978). Arion and the dolphins: Based on an ancient Greek legend. New York:
Scribner.

¢ |fyou looked at the field codes in Word now, you would see the code begins with “ADDIN EN.CITE,”
showing that it is now an EndNote citation.

IEI (=, R &‘- 474 1= RM Sample Doc.docx - Microsoft Word o B =R
Home Insert Page Layout References Mailings Review  View EndMote X7 « @
é@\ Go to EndNote Style: | APAGth ~ = Categorize References = Export to EndNote *
- i{ Edit & Manage Citationl(s) =] Update Citations and Bibliography Instant Formatting is On ~ dg}-l Preferences
QE:,E‘]T, - gg Edit Library Reference(s) @ Convert Citations and Bibliography ~ ? Help

Citations Bibliography ] Tools

0 - S S S B S S B N B R S S R - S S R R S NN S S S AR
— o 0 T T T T 0 0 0 0 0 0 T

Legends of the friendliness and helpfulness of dolphins have existed for centuries.{ ADDIN EN.CITE
: <EndNote><Cite><Author>Anderson</Author=<Year>1978</Year><RecNum>73</RecNum><Pages>23< -
- /Pages><DisplayText>(Anderson &amp; Adams, 1978, p. 23)</DisplayText><record><rec-

. number>73</rec-number><foreign-keys><key app="EN" db-

N id="tsddzs224e0999e9fr5xdfzh2d 2evzOpvaft” timestamp="1433285398">73</key></foreign-keys><ref-
: type name="Book">6</ref-type><contributors><authors><author>Anderson,

» (&5

L.<fauthor><author>Adams, A.</author=</authors></contributors><titles><title>Arion and the

dolphins: Based on an ancient Greek legend</title></titles><reprint-edition>Not in File</reprint-

edition><keywords><keyword>dolphin</keyword><keyword>dolphins</keyword><keyword>folklore
Greece</keyword></keywords><dates><year>1978</year><pub-dates><date>1978</date></pub-
dates></dates><pub-location>New York</pub-

; location=<publisher>Scribner</publisher><ishn>0684151286</isbn><label>77</label><urls></urls></re
’ cord></Cite></EndNote>}

" Reference List

Anderson, L., & Adams, A. (1978). Arion and the dolphins: Based on an ancient Greek legend. New York:
Scribner.

Both the Reference Manager ReflD and the EndNote record number are used as internal tracking numbers,
or identifiers, for the database. However, there are major differences in how these two identifiers are
assigned and behave.
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In Reference Manager, a ReflD is assigned to a record when it is created. The numbering system used to
assign that ReflD can be set by the user and that RefID can be edited by the user. If a record is copied or
moved from one database to another, Reference Manager will attempt to keep the same RefID in the new
database.

In EndNote, the record number is also assigned when the record is created, but how it is assigned and how
it is treated after that is very different. In EndNote—

e The record number assigned will always be the next sequential number after the last number
assigned by the program. This means if you have 999 records in a library, numbered sequentially
from 1 to 999, and delete 900 of them, the next record number assigned will still be 1,000.

o Ifarecord in alibrary is deleted, the record number for that record will never again be used in that
library.

o Record numbers are assigned by EndNote and the user cannot change them.

e Ifarecord is moved or copied from one library to another, it will be assigned a new number in the
new library.

e [farecord is cut from the library and pasted back into the same library, it will be assigned a new
record number.

o |[f alibrary is synced between multiple computers using EndNote Sync, new record numbers are
assigned on the new computer. So record numbers will be different for the same library data
appearing in libraries on multiple computers.

In short, EndNote record numbers are not permanent. They change and should not be used as permanent
identifiers. If you must have a permanent identifier for tracking articles within your EndNote libraries, we
suggest using the Label field. When Reference Manager databases are converted to EndNote using the
method above, the old ReflD will automatically be added to the Label field of the EndNote record.

For Cite While You Write in Word documents, you can use the contents of the Label field instead of the
record number in temporary citations by changing the Temporary Citations setting in the preferences. Select
Preferences from the Edit menu, then Temporary Citations to make the change. If you have a group
working together, that setting would need to be changed for everybody in the group.

You can also set the library display to show the Label field instead of the record humber in the Display
Fields section of the preferences.
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